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1 Introduction

1.1 Purpose

This document describes user interface of sensor-less PMSM control, which is based on
FM3/FMO+ series MCU. The description includes variable meaning and how to use the
customer interface.

1.2 Variable Naming Rule

Note: Add fan motor variable naming rule, for multi-motor control, main motor variable still
use prefix MotorQ_.

MotorX-XXX-XXX-XX : .
Variable unit

—>
—I—. Motor operation property 2

—>| Motor operation property 1

» Motor property

Figure 1-1: define the variables format
1.3 System Files Structure
DC fan motor files structure is listed as below.

Debug

Files
=2 J ArminverterPlatform - Debug
[(JHD_Glohal
[CIHOZ_Driver
— (1H03_todule
CIHD4_Application
(7
— (1 501_Glohal
[1502_Driver
— [(1503_Madule
[I504_Application
(3
(1 Output

Figure 1-2: DC Fan Motor Files Structure
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=
Debug it #define 573 _CLOE Main Frequency Z0M
Files fdefine MOTORL SHUNT NUMEER 2
B G ArminverterFlatform - Debug ~ #define SPEED_FROM OUT D
CIHO1_Glohal
[ HD2_Driver fdefine MOTORL U _PIN anol
— [IH03_Module fdefine MOTORL V_PIN AN0D
(1H04_Application $define MOTORL W_PIN
= (OH0E_Lser -
||: ’é:'i:?lr;'?t:ﬂ #defingy DC_V_PIN ANDZ
N Jeraee Seian fdefine MOTORL SPEED FIN iN03
F— 1 1SRh fdefine ADC Digit 1z
L— [ Uarth gdefine ADC REF 5.0
— 1 S07_Global
(1502_Driver gdefine VDC Amplifier Multiple 87,275
g ggi_mgs#cleatian gdefine Motorl Current Rs 0.56
DSDE_User #define Motorl Current mplifier Multiple 1.9608
[ Cutput

Figure 1-3: DC Fan Motor User H files Structure

=
Debug "
Files
= ) ArminverterPlatform - Debug
[IHO_Global
[IH0Z_Driver
JE0 f##sdssdsdistsNotor Startup Darduetert###dsstisdsassssy
— [ HO3_todule 361 float Motorl Openloop_Inc_Current 4F5 = 0.1;
D HD‘q_.-&.FIFI“CﬂtIDﬂ 362 float Motorl Openloop_Currentd = 0.7;
363 float Motorl Orient Time$ = 0;/71.08;

® (1H05_User 364 ﬂz:t HZtZil:FEi::_Eng:peed_Hz - 0.1;//2./;1-

— [(1301_Global 365 float Motorl Closeloap Speed Hz = 1.5://2. 0f:
. 366 float Motorl Tnitial Speed Pre Cloze He = 3.0;/76.0F;

L 7] 5 _ _ _Fre_| |

4] D SDE_DI’I"J’EI’ 367 float Motorl Detect Direction Timed =0.&;
— D SDB_MDdU'E 368 float Motorl Inverse Rotor Erake Timed =1.0;

| ﬁ ond Annlication . 369 float Motorl Pre Closeloop_Timed = Z.0;

— 370 float Motorl Pre CloselLoop Current Mind =-0.1;

— |:| 371 float Motorl Pre Closeloop_Current Maxd =0.7:

ChIF:I |nit.c . 372 float Motorl Inc_ 3peeddcc_Timed = 0.001&;

1 | 373 flnat Metel Inc Speed MAX Hz = L.z
| Customer_Interface.c — i G - -

ISR.c

rmain.c

Uart.c

Wector Tahle.c
L] Output

Figure 1-4: DC Fan Motor User S files Structure

If using MO. M4 chips need change HO2_Driver Files, you can requirement the file from
Spansion engineers;

B (F ArminverterPlatiorm - Debug
[IHD1_Global

e

— [ 1HO03_Module

ool od A 1 A

Figure 1-5: DC Fan Motor Driver H files Structure
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2 System Build

2.1 Hardware Connect

When you get the Fan Motor EVB as show in Figure 2-1, please connect as below:
(@ AC power supply input interface;

@ Emulator debug interface;

@ Motor three phase line interface;

@ Slide rheostat control speed interface (used in the middle of the interface of two pin);

@ GUI debug interface;

Figure 2-1: Appearance of EVB
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2.2 System Files Structure

Open “IAR Embedded Workbench”, and click the “File>Open>Workspace”, the follow as
show in Figure 2-2.

/& IAR Embedded Workbench IDE . . |

ﬁ Edit View Project Tools Window Help

|| e v ) o A
Open > File... Ctrl+O
Close Workspace...

! Save Workspace Header/Source File Ctrl+Shift+H
| Close Workspace

ARARRRRRRR AR
Save Ctrl+S

Save As...

Save All

Page Setup...

Print... Ctrl+P

Recent Files >
Recent Workspaces >

Exit

Figure 2-2: IAR Embedded Workbench project open follow

According to the project file storage path and open it as follow (it same as “[FWLIB]Inverter
Platform-XXX-XXX-XX\edito\EWARM\ArmInverterPlatform.eww”), Figure 2-3 show the IAR
Embedded Workbench project Interface.

g IAR Embedded Workbench [OE

- — s - o® =B
Fle Edt View Project Tooks Window Help
NeEdo & R YRR EH U DD
ptova % | Motor Estmator.c | Motor, Protect.c | P10, Regulator < | P, Table.c [ Sege Shunt.c | O, ¢ | eid, Weaken.c | Fiter.c | 15R.c | Motor 1, Controkc | Motor3, Startup.c_ man.c | e
Filos
8 (3 ArminverterPlatform - Debug -
aaH0_Global
CIHO2_Driver r
LIH03_Module
(JH04_Applicaton
CIHOS_User
£3S01_Global
£1S02_Dnver
— C3503_Module
@ (3504_Apphcation
(80505 User extern StartPars "A:c:‘ S
LG'JMM extern unsigned char ;/:
extern unsigned short Mot
void Tizme Delay(unsigned long delay)
(
for (: delay > 1: delay-~)
{
asa (“nop*)
}
)
Asrlervenadiatfom - by
 JalC « = ’
Messages File Line
b J s (] y -
2 Frdnfies auid [ebigten %
Reade Errors 0, Wamings 0 Ln14, Col 37 =

Figure 2-3: IAR Embedded Workbench project Interface
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Figure 2-4 shows the firmware files structure, the file “Hardware_Config.h” contain the
hardware parameters, it is not necessary to change the hardware parameters usually, but if
changed the Demo EVB hardware parameters or customer use his own hardware, please
configure the hardware parameters and ensure that the parameters match the hardware.

“Customer_Interface.c” used to configure the motor parameters, if the motor used as default
with system, you not necessary to change the file too, but if you need, please configure it as
follow section:

‘Work x
(Debug v
Files
B (J ArminverterPlatform - Debug -
@ CI1HD1_Global
@ (IHD2_Driver
— CIHD3_Module
&1 CIHD5_User
— B AllinOne.h
F— [ Chip_tnith
| |Hardware_Config.h
— RISk
L— R Uarth
—T3501_Global
@ [1502_Driver Customer set Hardware
MO0 Mode parameters, firmware parameters
5 C1505_User and chip configuration parameters
Chip_lnit.c
[l 8]Customer_Interface.c
) main.c
= B Varte
[1Vector_Tablec
CETIOulpul

| AumnlrverterPlatform

Workspace | Source Browser x

Figure 2-4: Project Files Structure
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2.2.1 Configure Motor Parameters

If your motor parameters not in the default list.

Firstly, please define your motor type in the file “Customer_Interface.c”, for example, your
motor named as “Fan_Motor_Type_3”, show as Figure 2-5.

Workspace x

1 "H0 r\AllInOne.h"
[Debug #include "HOS_User\AllInOne.h

FI|BS "J Vadddddad d i d e e L g

8 & ArminverterPlatform - Dé { the parameters more detail co
@ H0 Qlobel L essenessnesnssisesssisnssine
—® (I H02_Driver
— [(1H03_Module
—® [ HO04_Application
—E_!lEIHDS_User 5 ot
[2) AllinOne.h or type veilin
|— [ Chip_lnith Fan h’o:or_:ﬁe_2 .
F— [) Hardware_Configh [#define Fan Motor type 3 ]
[ I1SR.h //#defl Motor type Midea
Uarth //#6 :Ho:ar::ype:sanjzv
— (1501_Global //#defi otor_type
—# [(1502_Driver //#define Fan Motor type aimeite
— [1S03_Module
[1504_Application
2 [1505_User

[0} Chip Init c.

||—EIEJII

Fa @ Uartc
L@ [ Vector_Tablec
—& [ Output

t,please reference the << Customer interface manual.pdf>>

sererer)
JreesesessssssesMotoy type definesssesessssssssssssss)

75L4H

Figure 2-5: Define Motor Name

Then, you can copy a set of others motor defined data, and change the parameters as
formats, such as motor pole pairs, inductance, resistance, inductive voltage constant, torque
constant and moment of inertia constant, show as Figure 2-6. You can directly using the
given parameters from motor factory, or measure it by yourself as the method as the follow
chapter.

B #ifdef Fan_Motor_type_3

JrEERERERERERE s Moboy ParYambeysrrrrrhrrbnmmnr s b nn/

unsigned char Motorl Fole Pairs = 4.0; //the pole pairs of rotor

float }‘.'o‘l.‘.or:l_l.d = 107; J/the d axis reductanc

float Motorl Lg = 107; //the g axis reductance

float Motorl Rs = 49; //the resistance between twvo phases (U,V eg.)
float Motorl Ke = 120; //inductive voltage constant

float Motorl K& = 0.39; //torque constant

float Motorl_Kj = 0.685; //moment of inertia constant

Figure 2-6: Define Motor Parameters
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2.2.2 Define Pl Parameters

Usually, the initial value of PI regulate does not need to be modified, when the system
running and program can adjust the parameters of speed loop and current loop according to
system status automatically, and the parameters of speed loop depending on the moment of
inertia, and the parameters of current loop depending on the value of resistance and
inductive. Figure 2-7 show the PI regulate parameter interface, for the details, please
reference the chapter of “Pl parameters”.

/r*ressssnssssssD] Daramters Regulate informationt*#+sssssssssssssnss/

float Motorl Dki = 6.0; //d axis current PI regulator integral constant

float Motorl Dkp = 200.0; //d axis current PI regulator proportion constant

float Motorl Qki = 6.0; () n I regulator integral constant

float Motorl Qkp = 20 X1 rent PI regulator proportion constant

float Motorl_Ski = 0.0 //speed PI regulator integral constant

float Motorl_Skp = 0.03; I//spee*‘ PI regulator proportion constant

float Motorl_Speed Inc_Acceleration Hz = 3.0; //the speed increase acceleration frequency value per second
float Motorl_Speed Dec_Acceleration Hz = 1.0; //the speed decrease acceleration frequency value per second

Figure 2-7: Pl Regulate Parameters

2.2.3 Define Start-up Parameters

Customer can define the parameters according to what status of motor start-up, such as if
you need orient and start-up with open loop, you need define the orient stage time and open
loop stage maximum current. If not, please use it as default. The increase speed of open
loop stage and the frequency of open loop change to close loop need to accordance with
motor inertia and the lowest frequency to work properly. The motor detect direction times
according to whether you need to start-up against the wind. If not need, please set it as 0. If
you need, please set it as a honzero, the number as smaller as better, and the typical values
is 0.2S. After select prepare close loop start-up method, you need define prepare close
stage maintain time and prepare close stage current value. And to define the open loop
stage speed increase value and maximum value of open loop stage increase and PWM
brake pulse increase time as show in Figure 2-8.

/"""""""'.\.’O:Cr S:dr:'\.'p Pdrd:e:‘.’!""""""""""'/

float Motorl OpenLoop_Inc_Current APS = 0.1;
float Motorl OpenLoop_CurrentA
float Motorl Orient_TimeS 0
float Motorl Force_Inc Speed Hz = 0.1;
float Motorl_Closeloop_Speed Hz = 2.0;
float Motorl_Initial_Speed Pre Close_Hz =2;
float Motorl Detect_Direction_TimeS =0.5;
float Motorl Inverse Rotor_Brake_TimeS
float Motorl Pre Closeloop_TimeS = 2.0;
float Motorl Pre_Closeloop Current MinA =0;

I
[¥)

float Motorl Pre_CloselLoop Current MaxA =0.2; cl
float Motorl_Inc_SpeedAcc_TimeS = 0.0018; eed
float Motorl_Inc_Speed MAX Hz = 1.2; eed
float Motorl PWM Brake_Inc_TimeS = 0.05; //the brake pvm pulse increase time

Figure 2-8: Motor Start-up Parameters
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2.2.4 Define Motor Protect Parameters

The motor protection parameters base on the system features, the maximum soft over
current value and maximum voltage and minimum voltage protection value must ensure that
the motor and EVB hardware are not damaged and normal operation. Usually, the voltage
protection value and error keeping time don’t need to modify. The motor protection
parameters show in Figure 2-9.

fEEEREREREFFEEFIMObor] pro‘;e:‘;ion parameters**********************K

float Motorl Over Currenti = 0.9; A/the maximum soft over current protection
unsigned short Motorl Max Do VoltageV = 4207 A/the maximum value of DC woltage 1s 400V
unsigned short Motorl Min Dc VoltageV = 20; A/the minimum value of DC woltage 1s 140V
unsigned char Motorl Error Keep TimeS = 107 A/ the maximum time error maintain

Figure 2-9: Motor Protection Parameters

2.2.5 Define Motor Running Parameters

To define the motor field value need according to the motor parameters and system
operation voltage, if the power supply can drive motor running in maximum speed, the motor
field value can set as zero. If not, please define the value as what you need, as proposal, the
maximum current field weaken value don’t more than sixty percent of the total current;

The value of dead time compensation need according to the motor parameters, if the motor’s
electrical characteristics as good as we need, we can ignore this value;

The dead time value according to the electrical characteristics of IPM or MOSFET and
hardware layout, to meet demand, the value as smaller as possible, because it can influence
of harmonic and control error;

Motor running maximum torque current according to the power of system;

To define the motor start running PWM carry frequency and the current implement frequency
according motor electrical characteristics, if the electromagnetic noise and the
characteristics of start-up are meet the requirements, the value does not need to modify. If
enable dynamic change carry frequency function, system can matching the suitable
frequency list in PWM carry frequency table to eliminate the noise.

In the same application domain, not need to modify the range of motor speed.
All the parameters in Figure 2-10 support online modification.

float Motorl |

float Motorl Comp MaxA = 0.2;

float Motorl_Is Maxh =

float Motorl Dead TimeUS =2

unsigned short Motorl PWM_Carry Frequency =15000;

unsigned short Motorl Current Carry Frequency=5000;
unsigned short Motorl Speed Max RPM = 1000;
unsigned short Motorl Speed Min RPM = 1280;
unsigned char Motorl Rotor_Direction = 1;
unsigned char Motorl Running Level = 4§
unsigned char Motorl Dynamic_PWM_Enable =0;
unsigned short Motorl PWM _Table([30] = |

Figure 2-10: Motor Running Parameters

2.2.6 Define Hardware Parameters

For to define the hardware parameters, please reference the detail of hardware parameters
configuration and calculation method in bellow chapter.
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2.3 Motor Start-up

2.3.1 Code Build

When all the parameters configure finished, we can get into the simulation and debug
interface. Firstly, we need build the project, there are two ways to achieve it, like show in
Figure 2-11 or Figure 2-12.

% ArminverterPlatform - IAR Embedded Waorkbench IDE
File Edit View Project Tools Window Help

0= ﬁ‘ | | | Fan_Motor_type_3
* | Motor1_E¢
Debug - =
i - un
Arml Platf ! e
=fm JArminverterPlatform| Options.. N
P S
& CIHO02_Driver Make .
— [OH03_Module - 1
@ CIHO4_Application —_—
H= COH0E_User Rebuild All
F— B AlinOne.h o
Chip_lnith 5
F— [ Hardware_Confi Stop Build n
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Figure 2-11: Code Build (1)
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Figure 2-12: Code Build (2)
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2.3.2 Download and Debug
Through the following ways achieve download code and enter debug interface.

The first way: like show in Figure 2-13;

% ArminverterP| Mot mbedded Workbench IDE
File Edit Vielt [Project| fools Window Help
O = T iles...
Workspace Add Group...
[Debug Import File List...
Files Add Project Connection...
EYS ] rminverd Edit Configurations...
CIH01_GI
CoHoz Dn  Remeve
g :Ei—:l Create New Project...
@
= HO5 1 Add Existing Project...
l_ Al”.n Options... Alt+F7
F— B3 Crip F i
||: Harct Version Control System v
k1 ISR
— [ Uart Make F
_ g gg;—g‘ Compile Ctrl+F7
il
—ESU37MC Rebuild All
= 00804 Ap Clean
Coof Batch build... Fe
Curre
DT_ Stop Build Ctrl+Break
Field
Filter, Download and Debug Ctrl+D
I5R.g
mam Make & Restart Debugger Ctrl+R
c] hdoto
hota Restart Debugger Ctrl+Shift+R
Mot Download 3
FID_|
Pms SFR Setup
Singl Open Device File »
L P <vrenm l -

Figure 2-13: Download Code (1)
The second way: you can click on the shortcut button like show in Figure 2-14;

> & o Rt P
gulator | Motor1_Protect | Current_Sensor | SVPWM_Caloulz

e h ahkE

Figure 2-14: Download Code (2)
Through the above operation can enter the interface as show in Figure 2-15

Document Number/Document Name — Page 16



w2 CYPRESS
MCU-AN-510119-E-20-DC-FanMotor_Cumtomer_Interface 'v‘

N EMBEDDED IN TOMORROW
Chapter 2 System Build

@ AmirwerterPlatiorm - LAR Embeddad Workbanch IDE - - _— Lol [
File Edit View Project Debug Disassembly J-Link Tools Window Help
wienapses .

man | Custormer Interface |chip it [Uart | Allmone | chi it | Harsware Cont

[Debun Velue
Files @
3 AminvortorPiatiorm - Dabug ’
8 CIHDT_Global &
b= (102 _Diiver 3
{— CIHD3 Module &
F-@ C1H04_Application REP @
T Maion 000000000
o
0
0
0
- 08_TargeiSpesd_He 0
022_TargetSpeed_Hz 0
- 022 TergetomegaiNCTs 0
022_TorgelOmegaDECTs 0
£3 Eloc_RotorThata 0
Angleria 0
SpeedPl_EN \0' (000}
o plete \0° (0m00)
e N0t (0x00)
0 (0=00)
1 N0t (0x00) [=
—aoumn 0" (0m00)
\0° (0x00)
0" (0x00)
+
Motord_SeftTimer.Tasesl > (1000))
- REM = GRalcOZADC(MOTORL SEEED BINI>>:
i1y
tor1_Startar.Erzor Keep Tine) 0 (0x00) .
hamirvstePaten - i

Wiorkspace [Regites | Daassenbly |Regster [Regster % | «

- Findin Fies |DebugLog _ Live Watch
D @& & B @] o | FanMotortype Y W ] PO B ahob S8 [0 LW 22X . .

Figure 2-15: Debug Interface

2.3.3 Run Program and Motor

4
Click the button in the Figure 2-16 “ =" " or press “F5” on the keyboard can make the
program running, in this mode, program can response the instructions what we send and
collect data and feedback the program state.

2aLE 22X

Figure 2-16: Program Control Button

Through “View>Live Watch” enter the variables monitored interface as show in Figure 2-17,
type in the global variable name in “Expression” bar. For example, add the architecture
“Motorl_RunPar” and unfold it, set the “Q0_TargetSpeed_RPM” value as a nonzero number
and press “Enter”, the motor start-up finished. After motor start-up, we need modify the
parameters according to the motor running state and the current waveform display on the
oscilloscope.
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Live Watch =

Expression Walug Location it
] RurPar <struct> O0=200000DC
Q0_TargetSpeed_RPM_M. 0x200000EQ
Q0_TargetSpeed_RPM_Min 180 0x200000E4
C8_Estimate_Hz i} 0x200000ES
C8_Estimate_Hazt i} 0x200000EC
Status ‘~0' (0x00) Ox200000F0
ErroType 0=00000000 Ox200000F4
QB_WDCINYT 539 0=200000F3
QB_vhus 80924 O=200000FC
DeltaThetaTs 64701 O=20000100
DeltaThetakTs 3355 Oz20000104
08_TargetSpeed_Hz 768 Ox20000108
Q22_TargetSpesd_Hz 12603846 Ox2000010C
022_TargetOmegalNCTs 2914 020000110
Q22_TargetOmegaDECTs 62914 0=20000114
Elec_RotorTheta 1639339 Ox20000118
AngleEro 1] O=2000011C
SpesdF_EM v (0=01) 0x20000120
startup_complete_f Yot (0=01) 020000121
Funning_Stage 0 (0=00) O0z20000122
Funning_lesel O (0=00) O0=20000123
Closeloop_f o (0=02) O0z20000124

ChangeSpeed_EN L (0=01) O0z20000125 E
ChangePiPar_EN ‘\0' (0=x00) 0x20000126
SpeedPiMode ‘~0' (0=x00) 020000127
i StartPiPar_Awailab_Time a Ox20000128
#  Motorl_BEMF_EstimPar <s=truct> Ox20000000
= Motorl_2rCurrentRef cstruct > O0x20000294
#  Motorl_3sCurrent <struct 0x20000288
& Motorl_StanPar <struct: O0=2000008C
#  Motorl _SWPWPar <struct: Ox2000012C
#  Motorl P Tahle {arravr 020000318

Figure 2-17: Variables Monitored Interface
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2.4 Motor Performance Debug

2.4.1 Start-up Debug
For different start-up mode, you can configuration the parameters as follow:

1. Prepare close loop start-up mode;
The parameters configuration is show in Figure 2-18.

Live Watch
Expression Value
+ Motorl_RunPar {<struct>

Motor1_OpenLoop_Inc_Current.. 1 .00000001E-1

Motorl_OpenLoop_CurrentA 3.00000012E-1
Motorl_Orient_TimeS 0.0
Motor1 _Force_Inc_Speed_Hz 1.00000001E-1
Motorl_CloselLoop_Speed_Hz 2.0
Motor1 _Initial_Speed_Pre_Clos... 2.0
Motorl_Detect_Direction_TimeS 0.5
Motor1_Pre_Closeloop_Curren.. 2.00000003E-1

Figure 2-18: Prepare Close Loop Start-up Mode
The current waveform is show in Figure 2-19.

Figure 2-19: Prepare Close Loop Start-up Mode (100mA/1s/scale)
2. No step orient and open loop start-up mode;

The parameters configuration is show in Figure 2-20.

Live Watch
Expression Value
#  Motorl_RunPar <struct>

Motorl_OpenLoop_Inc_Current.. 1.00000001E-1
Motor1_OpenLoop_CurrentA 3.00000012E-1
Motorl_Orient_TimeS 1.0
Motor1 _Force_Inc_Speed_Hz 1.00000001E-1
Motorl_Closeloop_Speed_Hz 2.0
Motor1_Initial_Speed_Pre_Clos... 1.0
Motorl_Detect_Direction_TimeS 0.5
Motorl_Pre_CloseLoop_Curren... 2.00000003E-1

Figure 2-20: No Step Orient and Open Loop Start-up Mode
The current waveform is show in Figure 2-21.
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Figure 2-21: No Step Orient and Open Loop Start-up Mode (100mA/1s/scale)
3. Step orient and open loop start-up mode;

The parameters configuration is show in Figure 2-22.

Live Watch
Expression Yalue

+  Motorl_RunPar <struct>
Motorl_OpenlLoop_Inc_Current.. 10.0 |
Motor1_OpenLoop_CurrentA 3.00000012E-1
Motorl _Orient_TimeS 1.0
Motorl_Force_lnc_Speed_Hz 1.00000001E-1
Motor1_Closeloop_Speed_Hz 2.0
Motor1_Initial_Speed_Pre_Clos... 1.0
Motorl_Detect_Direction_TimeS 0.5
Motorl_Pre_CloselLoop_Curren... 2.00000003E-1

Figure 2-22: Step Orient and Open Loop Start-up Mode
The current waveform is show in Figure 2-23.

Figure 2-23: Step Orient and Open Loop Start-up Mode (100mA/1s/scale)
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2.4.2 Pl Parameters Debug

Modify parameters of speed loop and current loop according to motor current waveform and
state.

1. Speed loop;
The parameters configuration is show in Figure 2-24.

Live Watch

Expression
+ Motoﬂ RunPar

Yalue

{struct>

P 15 1 I |
Motoﬂ _Ski 4.99999988E-3
Figure 2-24: Speed Loop Parameters

The current waveform is show in Figure 2-25.

Figure 2-25: Current Waveform (100mA/1s/scale)
Modify the parameters is show in Figure 2-26

Live Watch

Expression Yalue

+  Motorl_RunPar <struct>
Motor1 _Skp 1.00000001E-1
Motorl_Ski 5.00000023E-4

Figure 2-26: Speed Loop Parameters
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Now, the current waveform is show in Figure 2-27;

Figure 2-27: Current Waveform (100mA/1s/scale)

2. Current loop;
Modify the overlarge value to d and g component Pl parameters, as show in Figure

2-28;

Live Watch

Expression Yalue

i kMotor!_RunPar {ztruct:
botar!_Dkp 2000.0
hotor_Diki 4210
bAotor!_Clkp 2000.0
bAotor] _Ciki 42 .10

Figure 2-28: Current Loop Parameters

Then, the current waveform is show in Figure 2-29;

Figure 2-29: Current Waveform (100mA/1s/scale)

We can see that, current ripple and electromagnetic noise are very large.
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If we set the Pl parameters of d and g component are very small, as show in Figure

2-30;

kdotar! _Dikp 1.00000001E-1
kotor! _Diki 2.19999993E-3
kdotar! _Clkp 1.00000001E-1
kotor! _Ciki 2.19999993E-3
kdotorl _Fre_Closeloop_Curren.. 6.99999988E-1

= kotor] _2rCurrentFef c=truct:

- o12_d 1]

frn 2 g 993

Figure 2-30: Current Loop Parameters

Then, the current waveform is show in Figure 2-31.

Figure 2-31: Current Waveform (100mA/ls/scale)

We can see that, current can’t follow the value what the given current reference,
system is abnormal.

If we set the Pl parameters of d and g component are appropriate, as show in Figure

2-32;

Live Watch

Expression “alue

i kMotor!_RunPar {ztruct:
botar!_Dkp 3000
hotor_Diki 6.0
botor!_Clkp 300.0
hAotor] _Ciki 6.0
botorl_Pre_Closeloop_Curren... 2 .00000003E-1

Figure 2-32: Current Loop Parameters

Now, the current waveform as show in Figure 2-33;

Figure 2-33: Current Waveform (100mA/1s/scale)

We can see that, the current ripple is very little and the current follow current reference very
well.
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3 Variable Description

3.1 Customer Interface Variable List

Motorl: (Fan)

Motor Parameters
Motor1l_Pole_Pairs

Motorl_Ld

Motorl_Lq

Motor1l_Rs

Motorl_Ke

Motorl_Kt

Motorl_Kj

Pl Parameters Regulate information
Motor1_dki

Motor1_dkp

Motor1_gki

Motorl_gkp

Motor1_ski

Motor1_skp
Motor1l_Speed_Inc_Acceleration_Hz
Motor1_Speed_Dec_Acceleration_Hz
Motor Startup Parameters
Motor1l_OpenLoop_Inc_Current_APS
Motor1_Openloop_CurrentA
Motor1_Orient_TimeS
Motor1_Force_Inc_Speed_Hz
Motor1_CoseLoop_Speed_Hz
Motor1_Initial_Speed_Pre_Close_Hz
Motor1_Detect_Direction_TimeS
Motor1_Inverse_Rotor_Brake_TimeS
Motorl_Pre_CloseLoop_TimeS
Motor1_Pre_CloseLoop_Current_MinA
Motor1_Pre_CloseLoop_Current_MaxA
Motor1_Inc_SpeedAcc_TimeS
Motorl_Inc_Speed_MAX_Hz

- Motor pole pairs

- PMSM g axis phase inductance
- PMSM d axis phase inductance
-PMSM line resistor

- PMSM Back Electromotive Force coefficient

- PMSM torque const

- PMSM moment of inertia

- D axis current loop integral parameter

- D axis current loop proportion parameter

- Q axis current loop integral parameter

- Q axis current loop proportion parameter

- Speed loop integral parameter
- Speed loop proportion parameter
- Acceleration of speed loop

- Deceleration of speed loop

- Current vary step in open loop
- Current value in open loop
- Orient time

- Open loop acceleration

- Target speed when switching to closed loop

- Speed initial value before closed loop
- Detection time of rotational direction
- Brake time of motor reversion

- Time before closed loop

- Minimum current before closed loop
- Maximum current before closed loop
- Acceleration interval

- Maximum speed acceleration

Motor1l_PWM_Brake_Inc_TimeS - PWM brake mode brake duty ratio pulse increase time

Motorl protection parameters
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Motor1_Over_CurrentA - Software over current point
Motor1l_max_dcvoltageV - DC bus over voltage point
Motor1_min_dcvoltageV - DC bus under voltage point
Motorl_Error_keep_timeS - Fault maintain time

Motorl running parameters

Motorl_Field_Value - Maximum current of field value
Motor1l_Comp_MaxA - Dead time compensation offset balance current
Motor1_is_MaxA - Motor running maximum torque current
Motor1_dead_timeUS - Dead time value
Motor1l_PWM_Carry_Frequency - Motor start running PWM carry frequency
Motor1_Current_Carry_Frequency - Current implement frequency
Motorl_speed_Max_RPM -Motor running maximum speed
Motorl_speed_Min_RPM -Motor running minimum speed
Motor1_Rotor_direction -Motor running direction set
Motor1l_Running_Level -Set motor running stage
Motor1_Dynamic_PWM_Enable -Motor carrier dynamic change switching
Motor1_PWM_Table -Motor carrier frequency table

3.2 Motorl pole pairs
Data type: unsigned char
Description: PMSM pole pairs
Unit: none

Measure method: Turn motor rotor manually, test motor three-phase terminal line voltage
waveform, record turning revolution N and sine wave period number M, so

Motorl_pole_pairs = M/N

3.3 Motorl Ld

Data type: float

Description: PMSM d axis phase inductance

Unit: mH

Note: This parameter can be obtained from motor parameters or testing manually.
3.4 Motorl Lq

Data type: float

Description: PMSM q axis phase inductance

Unit: mH

Note: This parameter can be obtained from motor parameters or testing manually.
Measure method:

When motor is running, brake motor manually and measure the phase current waveform.
The current waveform is shown in Figure 3-1. Then Lq is calculated by using braking phase
current. This method is only applicable to SPM motor.
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Figure 3-1: Motor Current Waveform when Braking

When motor braking, the phase current waveform detail is shown in Figure 3-2.

) [z 200ps

Figure 3-2: Motor Current Waveform Detail

Consider Ke, Rs and Motorl_pole_pairs are known, record the following data when motor
braking:

The frequency of current waveform: F

The current falling time: T
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The current amplitude changes in falling time: A

The peak-peak current: Ao

So Lq is calculated as follows,

Motorl_Lqg = (F*60/ Motorl_pole_pairs* Motorl_Ke/1000 - Motorl_Res* A¢/2)*T/A
3.5 Motorl Res

Data type: float

Description: PMSM line resistor

Unit: Q

Measure method: Test any two phases of resistance using multi-meter, record three test
results Ruv, Rvw, Ruw, so

Motorl_Res = (Ruv +Rvw+ Ruw)/3

3.6 Motorl Ke

Data type: float

Description: PMSM Back Electromotive Force coefficient

Unit: V/Krpm

Measure method: Turn motor rotor rapidly, test motor three-phase terminal line voltage
waveform, and choose a relatively stable range of line voltage amplitude, record voltage
peak-peak value and frequency in the range.

Motorl Ke = V* Motorl_pole_pairs*5.8934465/F
3.7 Motorl_ Kt

Data type: float

Description: PMSM torque const

Unit: N-m/Arms

3.8 Motorl Kj

Data type: float

Description: PMSM moment of inertia

Unit: Kg-m2

3.9 Motorl_dki

Data type: float

Description: D axis current loop integral parameter
Unit: none

Range: about 0.3

3.10 Motorl_dkp

Data type: float

Description: D axis current loop proportion parameter
Unit: none

Range: about 0.3
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3.11 Motorl_qgki

Data type: float

Description: Q axis current loop integral parameter
Unit: none

Range: about 0.3

3.12 Motorl _gkp

Data type: float

Description: Q axis current loop proportion parameter
Unit: none

Range: about 0.3

3.13 Motorl_ski

Data type: float

Description: Speed loop integral parameter

Unit: none

Range: about 0.0005

3.14 Motorl_skp

Data type: float

Description: Speed loop proportion parameter
Unit: none

Range: about 0.3

3.15 Motorl_Speed_Inc_Acceleration_Hz
Data type: float

Description: Acceleration of speed loop

Unit: Hz

3.16 Motorl_Speed_Dec_Acceleration_Hz
Data type: float

Description: Deceleration of speed loop

Unit: Hz

3.17 Motorl_OpenLoop_Inc_Current_APS
Data type: float

Description: Current vary step in open loop

Unit: A

3.18 Motorl_OpenLoop_CurrentA

Data type: float

Description: Current value in open loop

Unit: A
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3.19 Motorl_Orient_TimeS

Data type: float

Description: Orient time

Unit: s

3.20 Motorl Force_Inc_Speed Hz

Data type: float

Description: Open loop acceleration

Unit: Hz

3.21 Motorl_CloseLoop_Speed_Hz

Data type: float

Description: Target speed when switching to closed loop
Unit: Hz

3.22 Motorl_Initial_Speed_Pre_Close Hz
Data type: float

Description: Speed initial value before closed loop
Unit: Hz

3.23 Motorl Detect_Direction_TimeS

Data type: float

Description: Detection time of rotational direction
Unit: s

3.24 Motorl_Inverse_Rotor_Brake TimeS
Data type: float

Description: Brake time of motor reversion

Unit: s

3.25 Motorl Pre_CloseLoop_TimeS

Data type: float

Description: Time before closed loop

Unit: s

3.26 Motorl _Pre_CloseLoop_Current_MinA
Data type: float

Description: Minimum current before closed loop
Unit: A

3.27 Motorl_Pre_CloseLoop_Current_MaxA
Data type: float

Description: Maximum current before closed loop
Unit: A
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3.28 Motorl Inc_SpeedAcc_TimeS
Data type: float

Description: Acceleration interval

Unit: s

3.29 Motorl Inc_Speed MAX Hz
Data type: float

Description: Maximum speed acceleration
Unit: Hz

3.30 Motorl PWM_Brake_Inc_TimeS
Data type: float

Description: the PWM brake acceleration times
Unit: S

3.31 Motorl_Over_CurrentA

Data type: float

Description: Software over current point
Unit: A

3.32 Motorl _max_dcvoltageV

Data type: unsigned short

Description: DC bus over voltage point
Unit: V

3.33 Motorl_min_dcvoltageV

Data type: unsigned short

Description: DC bus under voltage point
Unit: V

3.34 Motorl Error_keep_timeS

Data type: unsigned char

Description: Fault maintain time

Unit: s

3.35 Motorl Field Value

Data type: float

Description: Maximum current of field weaken
Unit: A

3.36 Motorl_Comp_MaxA

Data type: float

Description: the dead time compensation value of current
Unit: A
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3.37 Motorl_is_MaxA

Data type: float

Description: Maximum output current
Unit: A

3.38 Motorl_dead _timeUS

Data type: float

Description: PWM dead time

Unit: us

3.39 Motorl_PWM_Carry_Frequency
Data type: unsigned short

Description: PWM carrier frequency
Unit: Hz

3.40 Motorl_Current_Carry_Frequency
Data type: unsigned short

Description: Motor control algorithm frequency
Unit: Hz

3.41 Motorl _speed Max_RPM
Data type: unsigned short

Description: Maximum speed

Unit: RPM

3.42 Motorl_speed_Min_RPM
Data type: unsigned short

Description: Minimum speed

Unit: RPM

3.43 Motorl_Rotor_direction
Data type: unsigned char

Description: Motor rotate direction
Unit: none

Range: 0->clockwise, 1->anticlockwise
3.44 Motorl_Running_Level
Data type: unsigned char

Description: Motor running level

Unit: none

Range: 0->Brake, 1->Orient, 2->Open loop, 3->Closed loop, 4->Set running speed

3.45 Motorl _Dynamic_PWM_Enable
Data type: unsigned char
Description: switch of the Dynamic PWM function
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Unit: none

Range: 0->disable, 1->enable

3.46 Motorl PWM_Table

Data type: unsigned short

Description: the carry frequency of per frequency
Unit: KHZ
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4 Hardware Configuration

4.1 AD_OFFSET_NUM

Data type: macro define

Description: AD middle voltage calculator value 2 AP-OFFSET_NUM
Unit: None

4.2 AD_OFFEST_MAX_VALUE

Data type: macro define

Description: AD middle voltage maximum offset
Unit: None

4.3 Motorl_Control_mode

Data type: macro define

Description: Motorl control mode switch

Range: 0: Speed 1:Torque 2:VF 3: VF_Diagnose
4.4 MOTOR1 _PWM_POLAR_AVAILABLE
Data type: macro define

Description: Motorl control IMP polar

Range: 0: LOW_POLAR 1: HIGH_POLAR

4.5 SYS _CLOK

Data type: macro define

Description: MCU main frequency

Unit: MHz

Range: 0—20MHz

4.6 MOTOR1 _SHUNT NUMBER
Data type: macro define

Description: The number of sampling resistor
Unit: none

Range: 0, 1, 2

4.7 SPEED_FROM_OUT

Data type: macro define

Description: modify the speed whether the out AD
Unit: none

Range: 0: from the UART or debug set 1: from the out AD

4.8 MOTOR1_U_PIN
Data type: macro define

Description: AD channel of phase U current
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Unit: MCU pin

Range: ANOO—ANO5

49 MOTOR1_V_PIN

Data type: macro define

Description: AD channel of phase V current
Unit: MCU pin

Range: ANOO—ANO5

4.10 MOTOR1_W_PIN

Data type: macro define

Description: AD channel of phase W current
Unit: MCU pin

Range: ANOO—ANO5

4.11 DC_V_PIN

Data type: macro define

Description: AD channel of DC bus voltage
Unit: MCU pin

Range: ANOO—ANO5

4.12 MOTOR1_SPEED_PIN

Data type: macro define

Description: AD channel of speed

Unit: MCU pin

Range: ANOO—ANO5

4.13 ADC _Digit

Data type: macro define

Description: AD converter resolution

Unit: bit

Range: 10-bit, 12-bit

4.14 ADC_REF

Data type: macro define

Description: ADC reference voltage

Unit: V

Range: 1.8V/3.3V/5V

4.15 VDC_Amplifier_Multiple

Data type: macro define

Description: DC bus voltage amplifying circuit coefficient
Unit: V

Calculation process:
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VDC_Amplifier_Multiple = (R56+R55+R53)/R53

l—P
R56
224-1%,
[ w
R55
224-1% D6
:1}14143
| VDC AD
lR53 ——=CI%8
512-1% 104

Figure 4-1: DC Bus Voltage Amplifying Circuit
4.16 Motorl Current_Rs
Data type: macro define
Description: Current sampling resistance of Motorl
Unit: Q

Note: The current sampling circuit is shown in Figure 4-2, the sampling resistance is 0.47Q.

o) [ 1 P
(2] -] L)

Rd43 EA2 Rl
0. 47TRW-1% | 0. 47R2W-1% | [0 47R2W-1%

/77

Figure 4-2: Current Sampling Circuit
4.17 Motorl Current_Amplifier_Multiple
Data type: macro define
Description: Current amplifying circuit coefficient
Unit: none
Calculation process:
Motorl_Current_Amplifier_Multiple = R27/R24
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Figure 4-3: Current Amplifying Circuit
4.18 MOTOR1_BEMF_LPFK_MIN
Data type: macro define
Description: the minimum of motorl estimate filters K value
Unit: None
4.19 MOTOR1 BEMF_LPFK_MAX
Data type: macro define
Description: the maximum of motorl estimate filters K value
Unit: None
4.20 MOTOR1 BEMF _LPFK_MIN_HZ
Data type: macro define
Description: the minimum of motorl estimate cut-off frequency
Unit: None
4.21 MOTOR1_BEMF_LPFK_MAX HZ
Data type: macro define
Description: the maximum of motorl estimate cut-off frequency
Unit: None
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Chart 5-1: error code

Error code (Error Type)

Error type

remark

0x00

Initial state

0x01 Over DC voltage
0x02 Under DC voltage
0x04 Soft over current
0x08 Hardware over current
0x10 Loss phase

0x20 No connect the motor
0x40 AD offset error

0x80 Software watch dog
0x100 Lock the motor
0x200 Handle the error
0x400 Hardware watch dog
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3 CYPRESS

6 Additional Information

For more Information on cypress semiconductor products, visit the following websites:

website address:
http://www.cypess.com/
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